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Introduction 

There may be times when it is important to obtain the EP data from an engine but Internet access 
is not available. This document describes how to collect the engine data with a PC not connected 
to the Internet, save the data locally, and upload the data later when Internet access is available. 
Here we describe how to assign the settings for using a PicoScope PC Oscilloscope for capturing 
engine ‘signature’ data from the exhaust and oil dipstick or oil filler tubes. This information is not 
needed if you are using the EPReader software from Predictive Fleet Technologies since the 
parameters are system calculated within EPReader. After the data is collected and saved locally, 
the user can later establish an Internet connection and use the www.EnginePolygraph.com 
application to upload the signature data with inputs describing the vehicle, engine model, and 
testing conditions to the Engine Polygraph servers for analysis and report generation. The report 
generated are stored in the EP web application (www.EnginePolygraph.com) and also sent to the 
email address specified by the user. 

The Engine Polygraph® (www.EnginePolygraph.com) is an application ‘in the cloud’ to store the 
FirstLook® sensor output (signatures) from an engine for future reference and to, optionally, 
request an engine analysis report. To collect the signature data (waveforms), one uses an Engine 
Polygraph® kit that includes two piezoelectric sensors, an automotive PicoScope, your laptop and 
the Internet with a subscription to EnginePolygraph.com. 

This document covers the functionality of the online web-based application, 
www.enginepolygraph.com appropriate to uploading the psdata files from your PicoScope to the 
EP web application and for the analysis reports. Other documents describe details of the reports 
produced and the associated (optional) EPReader PC application (requiring Internet access) that 
simplifies the data collection and editing of the data obtained (the signature). Those documents 
are available for download from the landing page of www.enginepolygraph.com.  

An EP signature (Fig. 1) is a record of voltage from one or more piezoelectric sensors recording 
simultaneous pressure changes (pulses) from an exhaust sensor and a crankcase sensor and 
optionally additional sensors collecting data from other parts of an internal combustion engine. 
The value to these signatures is that internal combustion engines repeat firing in the cylinders of 
the engine in a regular fashion. If everything is working well in the engine the pulses repeat in 
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very regular waveforms; however, engine problems usually present variations that repeat every 
engine cycle (two revolutions for 4-stroke engines). 

The user may request an analysis (report) of the data in view of the engine model identified and 
parameters of the test conditions. Currently the report choices are Assessment, Diagnostic, or 
none. The Engine Polygraph® reports automate many of the steps that a user would perform 
manually in interpreting a ‘signature’. 

If your engine has an intermittent problem, you might run your PicoScope to collect 32 
consecutive waveforms and visually review them, looking for an example of what you think might 
be the intermittent problem. You can save that single signature and upload it with the ADD 
Signature function to get a Diagnostic report for that timeframe. (Try to find one that has the 
abnormality away from the very beginning, but somewhat near the early part of the waveform.) 

In Figure 1 below, the signature is from the exhaust (blue) and the pressure in the crankcase (red) 
from a 6 year old, V6 engine. The vertical dashed bars mark the boundaries of a 720° full 2 
rotations of the crankshaft which took 74.02 ms, indicating that the 4-stroke engine was running 
at ‘Load’ of 1621 rpm.  

The engine cycle, the rpm, and cylinder boundaries are calculated from the analysis of the 
waveform by the system. 

 

Figure 1. A EP Signature by using a PicoScope PC Oscilloscope. 
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Why are the signatures important? 

In a 4-stroke engine, each cylinder of a well-running engine fires once during two rotations of the 
crankshaft (every 720°); in a 2-stroke engine, every cylinder fires once during one rotation of the 
crankshaft (360°). 

In an engine with a problem of ‘physical integrity’, one or more (usually one) cylinders output an 
abnormal pressure, resulting in an irregular pulse that is quite obvious. We use the term, ‘physical 
integrity’ to refer to the engine moving parts: head gasket, valves, pistons, rings, cylinders, fuel 
delivery, or ignition. Depending on where the signature is taken and the nature of the 
abnormality, the problem can often be identified. In this way, an engine with a mechanical 
problem can be diagnosed. [If the engine has tripped an OBD code AND the engine shows physical 
component compromise, the problem might not be correctly identified by the code. Most codes 
assume that the engine has no mechanical problems (no loss of physical integrity) but might have 
sensor problems, or ancillary control system problems. If the engine has mechanical problems, 
the code may well be erroneous.]  

Over time, wear and tear on the engine will cause less-than-failure variation from cylinder to 
cylinder. Most engines are not ‘broken’, but many are dirty (carbon buildup) or parts wearing 
out. The cylinder that is changing the most is typically the one that will fail first. That is why it is 
important to ‘look back’ at the signatures of an engine over time to identify if one (or a few) 
cylinders are degrading and might need attention. By looking at the rate of degradation, one can 
estimate the future time of failure. In this way, the sensor data can be used for ‘predictive failure’ 
to give you the option of preventative maintenance/repair or retirement.  You may want to watch 
the videos on the EP Technology website: www.senxtech.com.  

The Engine Polygraph® (EP) application 

The Engine Polygraph application is designed for a shop of one or more people (mechanics and 
technicians) who will take EP signatures from engines. There are two ways to collect the signature 
data. One approach can be used if there is not Internet access at the site of the engine being 
tested. It is described in this document. The other approach that might be used is a PC based 
software, EPReader, that does require Internet access while obtaining the data but also provides 
prompts, edits, and a much simpler process. It is described in the downloadable EP Reader 
Installation and User Guide. 

For the non-Internet method, it is necessary to have the signature stored on your local computer, 
typically a laptop in the shop with your PC oscilloscope. The local storage of the signature can be 
done without connection to the internet. An overview of the procedure for the non-Internet 
method is described in the downloadable Polygraph Quick reference Guide. 

EnginePolygraph allows you to attach ‘index’ data to the signatures for easy future retrieval; 
the index data and the signature are then sent to the EnginePolygraph application. 
EnginePolygraph is a web-based application and database, so it is necessary that your computer 

mailto:info@PredictiveFleetTechnologies.com
http://www.senxtech.com/


 

© Predictive Fleet Technologies, Inc., 2024; All rights reserved; Patent numbers: US10253716 and US10818107 
info@PredictiveFleetTechnologies.com   Phone: 1-833-ENGANGL (364-2645) 

P
ag

e6
 

be attached to the internet, perhaps at a later time after you have collected the signature data, 
in case you do not have internet access at the vehicle location when obtaining the signature. 

Add a new Signature 

It is important to add the index information to a new signature when you upload it on the Add 
Signature screen.  

 

Figure 2. (Almost) empty screen to fill out when capturing data for EnginePolygraph.com 

For the cases when you are using the non-Internet approach for collecting the signature, we show 
an (almost) empty screen for what needs to be input to EnginePolygraph.com when you are 
Internet connected. See Figure 2. Copy this empty screen to write in the info of the engine you 
are testing at the time you are running the test for later keying when you are on the 
EnginePolygraph.com, ‘Add Signature’ screen.  
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The ’Upload File” (circled in red) opens access to your PC File Manager for you to select the file 

on your PC that contains the data from your remote (previous) test. The uploads must be one 

file at a time. 

The paper illustration on Fig. 2 has the Engine Manufacturer filled out so that the Engine Model 

pull-down displays. On a blank screen, the Model field will not appear until you make a 

selection of Manufacturer. 

The Owner field is the Fleet name if the vehicle/engine is part of a fleet. If not a Fleet, use a 

description relevant to you.  

The Vehicle id is the vehicle number painted on the door, hood, or somewhere visible if it 

belongs to the Fleet (Owner); if not part of a fleet, I like to use license number, but there is no 

edit unless it is part of the Fleet. 

The Engine Manufacturer is from a pulldown list that we at PFT maintain. Once an entry is 

selected, the Engine Model field appears with a pulldown of the engines that we have in our 

database, sorted by displacement (in liters) in ascending order. 

The Engine Configuration and Displacement are displayed from the values in our database for 

the Model that was selected. If you can’t find the Model in our database, pick one that is similar 

and enter the info for your engine in the Comments files and let us know at 

support@PredictiveFleetTechnologies.com so that we can add it and reprocess the signature. 

The Location entry will rarely require change if the shop name is used; the Measurement Date is 
pre-loaded to today’s date, so if this is an entry for a signature from times past, replace the 
current date with the correct date for the signature.  

The Odometer reading probably will not change between multiple signatures for the same 
vehicle on the same date. But be sure to verify it. It can be entered in miles, kilometers, or hours-
of-service. The engine coolant Temperature is also important to know because some 
interpretation (especially for diesels) is dependent on the engine temperature. If the input value 
is under 105, it will be interpreted as °C; otherwise as °F. 

Condition is important to be correct for valid interpretation of the signatures. For example, the 
blow-by is greatest in a cold-crank (‘c-c’) near the end of a compression stroke, but it is maximum 
in the power stroke during a hot test (‘Idle’ or ‘Load’). The RPM Source is a selection from a pull-
down of options. Choices include: 

a. None indicates that you want the system to provide a default that will be obtained based 
on the Condition and number of cylinders. RPM may be left blank. 

b. Estimate means that you will input a value for RPM that is based on reading a tachometer 
or other method to provide a reasonable RPM value. 

c. ECM would not be a valid selection when not using EPReader. 
d. Set RPM would not be a valid selection when not using EPReader. 
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e. Trigger would not be a valid selection when not using EPReader. 

If the RPM is known accurately, it is valuable in the interpretation of the signature. In the case 
of RPM, if the value input is less than 200 or greater than 6000, a report will not be generated; 
otherwise, it may be used in the RPM calculation process. If it is more than 15% off from the 
actual engine speed, it may make the calculation inaccurate. 

The ‘Channel x’ fields need to be aligned with the oscilloscope channels and how they are 
attached to the sensors. If you happen to discover a mix-up on the assignments after the fact, 
you may use the EDIT button on the Signatures screen to submit a revised assignment and get a 
new report. 

You typically will want to record the Purpose for the requested report: ‘Before’ indicates the 
signature is being taken before some procedure is to be considered; an ‘After is for a report on 
the engine ‘health’ following the procedure. Choose ‘Single’ if the report is a routine evaluation 
of the engine without an intended maintenance procedure that will be validated after the 
procedure; ‘Base’ is used to report an ‘as new’ engine report for future reference. 

The Trigger Cylinder is important if you have a sensor for identifying ignition events. If your 
sensor (often a current induction clamp or a spark antenna) is designed to detect the ignition 
events on only one cylinder, input the cylinder number that is monitored; if the sensor records 
the events for multiple cylinders, do not specify any one cylinder. The trigger signal is used to 
calculate RPM; but if one cylinder can be uniquely identified, it can be very useful in identifying 
which cylinder(s) has/have diagnosed conditions. 

You may want to input Comments to further uniquely represent this signature in the future or to 
‘group’ the signatures for your particular analysis or organization needs. 

You chose the report you desire in the Report Selection pull-down: Assessment, Diagnostic, or 
‘none’. If you chose a report, a ‘Send Report (PDF) to:’ email address will be requested. 

If the submitted signature does not have data that can generate a meaningful report, the system 
will produce a PDF ‘Exception’ report describing the issue and suggesting corrective action. You 
will not be charged for a request that results in this circumstance. The most common reason for 
inadequate data in the signature file for a meaningful report is that the PC oscilloscope settings 
might not be appropriate for the engine you are working with. Please review the Appendix: 
PicoScope Startup Settings if you want more information. 

PicoScope Settings for Engine Polygraph Signatures. 

The PicoScope software controls many important settings for capture, display, and storage of your 

FirstLook® Signature data. The key parameters are shown in Figure 3. This document is focused on use 

of the PicoScope to obtain Engine Polygraph® Assessment reports on engine physical integrity.  
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Figure 3. Image of the PicoScope screen with settings that we recommend signatures with Load 

Condition. 

The values of the PicoScope screen with settings that we recommend for signatures taken at Condition = 

Load (over 1000 rpm) are shown in Figure 3 above (Number of Samples = 40 kS and sweep duration = 

500 ms). However, if you are running your engine at Idle (400 – 1000 rpm), cut the Number of Samples 

from 40 k to 20 kS per second and increase the sweep time to 1 s. And for cold-crank (usually less than 

400 rpm) set Number of Samples = 20 kS and sweep = 1.5 s. 

We recommended that you save the settings for each Condition as a file on your PC. When you 

download the ‘[condition].pssettings’ where [Condition is one of (c-c, Idle, Load) and store it (Save As) 

somewhere on your PC, you can start your PicoScope6 Automotive application and chose File > Open to 

select the downloaded [condition].settings. This will import the settings to your session.   

We now will discuss why we provide the recommendations that we do and how you may modify them 

as needed.  This is not meant to replace your use of the PicoScope6 Automotive documentation. 

The settings and preferences screens are where you control some of these the settings.  First, let’s look 

at the ‘preferences’:  

1. The time interval displayed on the screen can be controlled on the Tools > Preferences > 

General screen. The choices are to set the time interval across the screen (Total collection time), 

or to set the total sweep interval in terms of the time between the 10 equi-distant vertical bars 

(Times per Division).  

This parameter is critical for obtaining a meaningful report since the software that generates the 

signature Assessment report requires at least 2.7 cycles of all cylinders firing. For a 4-stroke engine, 

that is 5.4 rotations of the crankcase.  If the engine is running at 1500 rpm, one 4-stroke cycle takes 

80ms, so the time (duration) on the screen should be 216 ms, and longer if the engine is running 

slower. We recommend 500 ms which should be acceptable until about 650 rpm (typical idle).  

Similarly for c-c and Idle. 

2. The Tools > Preferences > General screen also controls the Waveform Buffer. This parameter 

controls the number of waveforms that may be stored in the buffers.  

Although having up to 32 buffers is very useful for some analyses, we recommend that you set it to 

1 for signatures that are to be analyzed by the EnginePolygraph application. The reason is to make it 
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easier to save the signature on your PC and then sending it to EnginePolygraph for analysis. 

EnginePolygraph cannot take the set of signatures as a group for analyses, but can only process one 

at a time. 

For intermittent engine problems, you may want to look at 32 waveforms to find one that captures 

the abnormality of concern. Then save that one waveform under a unique name to be uploaded by 

EnginePolygraph.com for analysis. 

 Figure 4 shows the layout of the Preferences > General screen. You may want to review the settings 

on the other Preference tabs also.  

 

Figure 4. The PicoScope6 Tools > Preferences > General screen for controlling important parameters to 

get EnginePolygraph Assessment reports on engine physical integrity. 

3. The Tools > Preferences > Updates tab allows you to check the ‘Don’t check for updates’ box to 

turn off the default to have Pico check your version umber against updates.  

You will NOT want to update your version of the PicoScope 6 Automotive software because EP will 

not work with PicoScope 7 Automotive software. 
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4. Other parameters that can be stored in your Default settings can be altered immediately below 

the menu bar.  

Under Tools, is the sample frequency. See Fig. 5. We recommend about 40 kS (40,000 samples per 

second) to get good detail of what is going on in the engine at over 1000 rpm. We do not have any 

properties that we consider in the analysis that interpret data at a higher frequency, but higher 

frequency of sampling increases the file size and slows down the ability of the PC to do any other 

work. For Idle and c-c, use the values described earlier. 

On the next row under the menu bar, the voltage range for each channel is displayed; it can be changed 

and stored in the Default settings. ‘Auto’ might be the best choice for all active channels. The 

pressure/voltage varies by many factors such as rpm, diameter of tailpipe, etc. 

 

Figure 5. These are the Startup Settings on the PicoScope6 File > Setup Settings Menu.  

Once you have selected the settings that you want to use going forward, we recommend that you click 

‘Save User Default Settings’ to save them. But we also recommend that you click on ‘Load User Default 

Settings on Startup’ to simplify future use of this PC for use with EnginePolygraph. Below is a short 

description of the behavior for each of the menu items of the File > Startup Settings list. 

1. The ‘Save Settings As …’ allows you to save the settings under a unique name in a specific 

directory of your choice for future reference.  

2. ‘Save User Default Settings’ is used to save the current settings as your Defaults in the future. 
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3. ‘Reset User Default Settings’  can be used to go back to the last saved Default Settings in case 

you have changed the settings during the session, but now want to go back to the Default 

Settings. 

4. Use ‘Load User Default Settings’ to read the Default Settings and use them going forward. 

5. ‘Restore Last Session’ will reload the settings from your previous session. 

6. ‘Load Factory Settings’ will reset the current settings to the values from the download of your 

PicoScope software. 

7. Checking ‘Load User Default Settings on Startup’ will cause the system to load the default 

settings in the future on start-up. 

8. Or you may check ‘Restore Last Session on Startup’, if that is what you prefer. 

If you are not fully trained on the use of your PicoScope, you will want to use the Pico literature and 

Help screens to get full value from your investment. The material above is presented to focus on the 

capabilities important for using your PicoScope to obtain EP signatures for EnginePolygraph Engine 

Integrity Reports. 

We wish you great success on the use of your PicoScope and the Engine Polygraph® 

(www.EnginePolygraph.com). Engine Polygraph is a product of Predictive Fleet Technologies, Inc. 

 

 

Contact Us 

Learn more about us at www.PredictiveFleetTechnologies.com, www.EnginePolygraph.com, 
and www.EngineAngel.com. 

For specific questions about the Engine Polygraph® functionality, please email us at 
support@PredictiveFleetTechnologies.com or call us at 1-833-364-2645. 

1 Engine Polygraph® is a trademark of Predictive Fleet Technologies, Inc., Midland. MI 
2Predictive Fleet Technologies®, PFT, Engine Angel®, and Engine Polygraph® are trademarks of Predictive Fleet 
Technologies, Inc., Inc., Midland, MI 
 
No part of this publication may be reproduced or transmitted in any form or by any means, electronic, mechanical, 
photocopying, recording, or otherwise, to parties outside your organization as a customer or customer prospect 
without the prior written permission of PFT.   

mailto:info@PredictiveFleetTechnologies.com
http://www.senxsm.com/
http://www.predictivefleettechnologies.com/
http://www.senxsm.com/
http://www.engineangel.com/
mailto:support@engineangel.com

